Opgave

Nolde Museet

| gang med Dreamweaver m

Opgavebeskrivelse

Lav et website om Nolde Museet i Sgnderjylland. Opgaven fgrer dig
igennem de basale ting hvad angar opbygningen af en side med
CSS. Der er ikke tale om et komplet site, men du kan bruge opga-
ven som en slags skabelon til at opbygge mere omfattende sider
ud fra. Hvis du ikke er fortrolig med at oprette et eksternt CSS, bgr
du laese afsnittet om CSS fgrst og prgve at lave et eksternt CSS ud
fra navigationssedlen om CSS.
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Nolde-mu
1 1526 kebte Emil Nelde garden
Seebillgdrd nogle fa km syd for
gresnsen. Her byggede og
indrettede han =ig sammen med
Ada Molde. Det meget specielle hus
blev opfert efter Moldes udkast, en
funkiswvilla med atelier, der bred og
bryder totalt med byggetraditionen i
marsken. Noget der szerligt lz=2gges
meerke til, fordi to meget smukke
marskgarde pa wvesrfter ligger pa
hwver side af Moldes =zere hus.
Hans liveveerk, en del af kunsten,
huset og haven er sikret eftertiden
gennem den testamentariske
grundleeggelse af “Stiftung Seebiill
Ada und Emil Molde”.
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Mal og CSS

Stgrrelse: 450 x 400 px (master), baggrundsfarve lys gul
header (div'en der indeholder overskriften): 450 x 50 px

left (div’en til venstre): bredde 200 px

right (div’en til hgjre): bredde 200 px

topmargin: 50 px

Overskrift (h1): Verdana 40 px, bld farve som slipset
Mellemrubrik (h2) : Verdana 24 px, bold, bld farve som slipset
Brgdtekst: Verdana 11 px, bla farve som slipset

Indholdet er centreret horisontalt i browservinduet
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Nolde Museet

Layout Objects

Farm

Hyperlink

Ermil Uil

Div Tag
AP Div

Forberedelse

Opret en mappe kaldet nolde.

| gang med Dreamweaver m

Hent mappen nolde_grafik i kursusmaterialet, og placér den i map-

pen nolde.

Byg siden

Abn Dreamweaver og opret et nyt site kaldet nolde.
Opret index.html, abn filen og giv den titlen Nolde Museet.
Veelg Insert > Layout Objects > div tag

Veelg ID og kald den for master

Veelg New CSS Rule

Insert Div Tag

Insert: |At insertion point [V]
Class: | [v]
) 10 |master [v]

>
> Mew £35 Rule

Mew CS5 Rule

Selector Type:

Choose a contextual selector bype For wour 55 rule.

|ID (applies to only one HTML element)

Selector Name:

Choose ar enter a name For your seleckar.

#masker

This selectar nanme will apply wour rule ko
all HTML elements with id "master”,

Rule Definition:

Choose where your rule will be defined.

—_— |(New Stvle Sheet File)

Da det er den fgrste style, der
bliver defineret, skal program-
met fgrst vide, om der er tale
om et internt eller eksternt
CSS. Veelg New Style Sheet
File for at oprette et eksternt
CSsS.
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Nolde Museet

Dialogboksen hvor du skal navngive og
arkivere det eksterne CSS.

Save Style Sheet File As

Select file name from: (2 File system
Data sources Server...

Save in: | 29 nolde Il] O ¥

h_notes

IS cssarafik. . .

T basic.css Kald,ﬁlen fqr basic, og
placér den i roden af sitet.
Filen kan hedde hvad som
helst, blot ikke indeholde
specialtegn som ®,9,3 o.l.

File name: basic.css [

Nar CSS filen er arkiveret abnes CSS editoren:

Definér master

C55 Rule Definition for Zmaster in basic.css

Category Positioning

Tvpe

Background i )

Block Postion; | relative [ Som den eneste div,

B 3
Forder width: | 450 || |px  [v skal masteren have
Fanen e Heicht: (400 [v| [px [v] position relativ.

Positioning  |Extensions Flacemertt

Top: | 50 vl p L'

CSS Rule Definition for #Fmaster in basic.css

Cakegory Biox
Tvpe

gizl.::kkgruund Width: | 430 VI px VI Float: I:E
Bi
Fanen BE::Ier Height: | 400 vl p vl Clear: I:E

Box I';ist_t_ . Padding Matgin .
sitioning Same For all [semefor. HOjre og ven-

Exkensions .
o[ [V T[] Stre margin
. saettes til auto
S i for at centrere
Bottorn: BDttnm: siden horison-

Left: Left: talt.
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-~

C55 Rule Definition for #Fmaster in basic.css Vaelg en lys
| farve til
Zaktegary Background g:gge:‘u ne— t
g;gl?gmund / den ved at
Elock Backaround-color: E #FFC Klikke p3
?Dx' Raclaranind-immana I den Il”e far'
vefirkant.

Klik OK og se masteren pa siden.

= S 1

200 |3IJIJ |4DIJ |SDD |EDD o0
I T T T T T T I T I Y O A A A I A A

Fanen
Background
Current
All Rules
[= basic.css
L #master
Properties for "#master”
E= At & &2
(N = 55 Rule

basic.css optraader nu i
CSS paletten med den
farste style defineret.

Contemt for 1d "marter” Goee Here

Definér "*"”

Da de forskellige browsere fortolker CSS forskelligt, er
det en god idé at nulstille margin og padding pa alle
elementer, dette ggres ved at definere en universel
selector (en stjerne). P& denne made fjerner du al luft
der er lagt pd default i programmet og dette betyder
at du selv har mere styr pa de enkelte elementers
placering.

Veelg New CSS rule nederst i CSS paletten.

2= Agj[*+ i

3
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Nolde Museet

Fanen
Box

Egenskaberne for “*”

| gang med Dreamweaver m

Veelg ID og kald den for *

New CSS Rule

Selector Type:
Choose a contextual selector type for your CS5 rule,

|ID (applies to only one HTML element) v

Selector Name:

Choose or enter a name for your selector,

- [x]

Rule Definition:

Choose where your rule will be defined.

basic.css v |

(55 Rule Definition for * in basic.css

Cakegory Bo

Type

B d 1 1

Biox 1 1

I';ist_t_ ) Fadding Margin

ositioning

Exbensions [¥] 3ame For aII : [#] 5ame For aII ;
Right: 0 px Right: 0 ks
Bottom: 0 pi Boktom: | 0 px
Left: 0 P Left: 0 i

I CSS paletten kan de 2 styles ses. Hvis
man klikker p& dem, kan man forneden

i paletten se deres egenskaber. Man kan
redigere alle styles her i stedet for at abne
editoren.

EEry —
(W e

All Rules

[= basic.css s
Fmaster u

= [se]
Properties for "~
margin Opx
padding Opx
Add Property

E= Agjfed @fi s |

NS
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wsert Div Tag

]
[
vl

Insert: |At insertion point

Class: |

I | header

Mew CS5 Rule

Fanen
Positioning

<body>
<div id="master">

<div id="header">Content
for id "header" Goes Here</
div>

</div>

... 0g s8dan skal kodestumpen
se ud i kodevinduet

| gang med Dreamweaver m

Definér header

Headeren bruges i dette eksempel til overskriften. Det kunne lige
sa godt have veeret til en menu, det er blot en kasse som ligger i
et lag ovenpa masteren, der kan fyldes indhold i. Det kan vaere lidt
vanskeligt at fa placeret cursoren det rigtige sted, nar head skal
indsaettes. Det sikreste er at abne kodevisningen og placere
cursoren mellem <div id=master> og </div>. Du kan ogsa holde
gje med, hvad er star i fletet ID i Properties - der skal sta master.

)

ID master -

Title: | nolde museet

. &.
E00

EL & | 8% &
ey E § Faormat [Nune

[T i ‘master” Goes Here

Veaelg Insert Layout Objects > div tag.
Veelg ID og kald den for header.
Veelg New CSS Rule.

. Div’en ligger inde
CSS Rule Definition for #header in basic.css i masteren, Og det
er gverste venstre

Category Positioning

Type
Background Posiion: | absolute [« whity. | |v] hjgrne, der er ud-
Eorder it Zindex: gangspunktet.
List 1 3
Positioning Height: . Overflov: _ Menuen placeres
Extensions Flacement Clip
| | i 10 px nede for at
kf; ot luft
Right: Right: Skabe lidt Iu
potton: [ o] otton: [ [o] mellem tekst og
o o] e[ ] baggrund.

Content for id "header" Goes Here

Her ses div'en head inde i masteren. Div’en er gennemsigtig.
Her jeg har her valgt at give den en lidt mgrkere gul farve, blot for
at du tydeligere kan se, hvor den ligger.

¥
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Nolde Museet

Insert Div Tag

Definér left

| gang med Dreamweaver m

Veelg Insert Layout Objects > div tag.
Veaelg ID og kald den for left.
Valg New CSS Rule.

CSS Rule definition for left

Insert: |At insertion point M

Class: | M
I | left M
Mew €55 Buls

Insert Div Tag

Insert: |At insertion point M

Class: | M
Io: |right| M
MNew C55 Rule

Caktegory Positioning
Type
giaocciground Pasition: . Wisibilits
Border wat [0 v] [ [v] 2
IIE‘I;;iti-:ning Height: - CrverFlow
Extensions Placement Clip
roei0 [wlfee [d]| e[
might:|  [w] Right: |:
Botkam: Baktam: I:
Left: - o [w] | uef|

Definér right

Veaelg Insert Layout Objects > div tag.
Veaelg ID og kald den for right.

Veaelg New CSS Rule.

CSS Rule definition for Fright

Cateqgary Positioning

Type

E d

Blicckligmun Position: | absolute Ill Vis
Ei

Bgfder width: | 200 vl P VI Z1
List ? ]

Fositioning Height: - Crve
Extensions Placerment Clip

Top: (60 [w][ox  [w]  Tem
right: |10l [w||px  [s| @ Right
Battom: | v Bottam:

Left: | [ Left:

Hgjden defineres

ikke. Billedet spaender
automatisk kassen ud.
Placeringen 60 px fra
top er malt fra maste-
rens overkant.

Bemaerk at det nu er
afstanden fra hgijre,
der defineres.
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Fanen
Type

| gang med Dreamweaver m

Definér body

Body er ikke en div, body er ikke en kasse. Body et et tagstyle,
hvor du kan definere font (skrift) til hele sitet, baggrundsfarve til
hele skaermen eller baggrundsbillede til hele skaermen. I opgaven
her defineres fonten til brgdteksten.

Vaelg New CSS Rule i CSS paletten.
Veelg Tag og kald den for body.

Mew 35 Rule
| P9

||‘h b oL [;;] ||m--|..:n...

w €SS Rule

elector Type:

hoose a contextual selector bype For vour €35 rule,

H lil

|Tag (redefines an HTML element)

elector Name:

hoose or enter & name For your selector,

| body|

—

This selectar name will apply vour rule ta
all <body = elements.

Less Specific IMore Specific

ule Definition:

hoose where your rule will be defined.

]

| basic, css

Font, stgrrelse og farve.

'S5 Rule Definition for body in basic.css

Category Type

Type

Eizccigmund Fant-family: | werdana, Geneva, sans-serif L
ggrder Fonk-size: I“—Mlpx_’il Fonkt-weight: I:
Iﬁlziitioning Font-skyle: - Font-wariant: I:
Extensions Line-height - Test-transform: I:

Text-decoration: [ underline Colar: ﬂ #O6C
[overline

[line-thraugh

[ blirk.

Jnone

NS
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Mew €55 Rule

Selector Type:

| gang med Dreamweaver m

Definér hl og h2

Overskrift og underubrik er heller ikke div’er. Det er ikke kasser,
men tagstyles der bruges til at definere udseendet af overskriften
0og underrubrikken.

Veaelg New CSS Rule i CSS paletten.
Veelg Tag og kald den for hl1.

L

= [P B P

CSS Rule Definition for h1 in basic.css

Selector Name:

Chaose or enter & name Far your selector,

\ hi|

New CSS Rule

Selector Type:
Choose a contextual selector type For your C35 1

|Tag (redefines an HTML element)

Selector Name:

Chaose ot enter a name Far your selectar.

| he|

Choose a contextual selector bype For your C55 rule. Categary Twpe
Tag (redefines an HTML element) Type
Background -
Bloc};;g Fant-Farmily: | Verdana, Geneva, sans-serif|

Font-weight;

Box
Border Font-size: | 40 vl P vl
List 3
Positioning Fant-skyle: -
Line-height: -

Extensions
Text-decaration: []underline

Fonk-vatiant:

Text-transform:

Calar: ﬂ #06C

i

[ rwserline

Veaelg New CSS Rule i CSS paletten.
Veelg Tag og kald den for h2.

Mew 55 Rule
L)

[P B P

'SS Rule Definition for h2 in basic.css

Cakegary

Tvpe
Background
Block

Baox

Border

List
Posikioning
Extensions

Type

Font-family: | Yerdana, Geneva, sans-serif
M ¥
Fonk-style: -

Line-height: - Text-transform;
Color: || #0sC

Font-weight: | bold

Font-wariant:

Faork-size: | 13

Il

Text-decoration: [ |underline

[Joverline

CS8 STYLES ﬁ

S8 skulle alle styles veere definerede, og

nu kan de sa tilknyttes siden.
Til hgjre herfor ses en oversigt over alle
styles til siden.

Current

All Rules

= basic.css
#masker
*
#header
#left
#right
body
h1

hz

NS

Erhvervsskolernes Forlag



Opgave

Nolde Museet

| gang med Dreamweaver m

Erstat teksten “Content ..” med den rigtige overskrift: Nolde Museet.
Markér teksten og veelg i Properties Format > Heading 1

Content for 1d "header" Goes Here

<hody > <div#master> <div#header>
PROPERTIES
<% HTML Format (Feading T " Clas
B css ID | Mone w Lin

Kopier teksten fra txt. dokumentet, indsaet den i div right. Markér
gverste linje og veelg i Properties Format > Heading 2

<body > <div#master= <div#content= <div.right>

PROPERTIES

Farmat i s
B css D Nre /v

Traek billedet ind i div left.
Det faerdige resultat set i designvisning.

g Nolde iVIuseet

=]
Nolde-museet

[ 1926 kebte Emil Molde garden
Eeebillgird nogle £8 krn svd for
hreensen. Her byggede og
ndrettede han sig samrmmen med
Bida Molde, Det meget specielle hus
blew opfart efter Moldes udkast, en
Funkisvilla med atelier, der brad og
bryder totalt rmed byggetraditionen i
fnarsken., Moget der sarligt le2gges
Fnzerke til, fordi to meget smukle
marskgirde pad verfter ligger pa
fver side af Moldes sare hus,

Hans livsvasrk, en del af kunsten,
huset og haven er sikret eftertiden
hennerm den testamentariske
Orundlzeggelse af “Stiftung Seebill
fida und Eroil Molde”,

M 1 8Mn Y -I%
Ved at flytte lidt p& div left og div right, er det muligt at fa fzelles
overkant pa de 2 spalter, det vil pynte pa resultatet. Nar du rykker
med et lag inde pa siden, bliver malene automatisk opdateret i
CSS filen.
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